
SAW32/SAWPlus32 Latest Release Info

Note: Full advantage of the new 32 Bit Architecture can only be realized using the NT platform with 
64 megs of RAM or higher. Proper handling and prioritizing of MultiThreads and Processors is not 
fully implemented in the Windows 95 platform. A definite increase in performance over the 16 Bit 
SAW/SAWPlus should be observed in 95, but in most cases, to observe the maximum performance 
increases will require Windows NT. In all cases minimum recommended RAM requirements are 32 
megs for SAW32 and 64 megs for SAWPlus32. 32 megs is not enough for SAWPlus32... eratic and 
extremely slow performance will most likely occur because Windows will be constantly swapping
memory buffers to and from the virtual memory swap file.

Note: SAW32/SAWPlus32 requires a minimum of 256 colors for its graphics. However, to avoid 
problems with Windows sharing palettes among applications, we strongly reccomend setting your 
display to 16 Bit (65535) colors. This will eliminate screen color changes and palette corruption that is 
inherent in the 256 color mode. Note that you might need a video card with more memory in order to 
reach the higher color setting at high screen resolutions.

Note: If you are running Windows 95 we strongly suggest modifying the Virtual Memory SwapFile 
size by going to the Control Panel/System/System properties/Performance/Virtual memory and set the 
max and min to the same value to prevent repeated resizing of the swapfile. 16Meg is a good value. 
Other Windows 95 suggestions can be found in the HelpFile under the Troubleshooting Windows95 
section.

Note: Importing EDL Files from SAW/SAWPlus is a one way operation. Once saved in 
SAW32/SAWPlus32, they are no longer useable in SAW/SAWPlus. We suggest creating a new 
EDL32 folder and copying all SAW/SAWPlus EDL Files that you plan to import into that folder. Then
operate on those copies so the originals are still left unchanged.

Note: Many operations will use the Default Beep through the computer speaker as an indication of the 
operation results. We suggest adjusting the Default Beep sound in the Control Panel Sounds section to 
NONE, so that these sounds do not play through your soundcard to your speakers. In a studio 
environment, with loud monitoring, this could be bothersome.

Version 2.3

Enhancements
* The Audio Hardware Setup has been altered to allow for separate Device Out and In selections. 

Use the Toggle Button at the top of the setup window to switch between Out Devices and In 
Devices. This has been done to handle the newer soundcards with uneven numbers of inputs and 



outputs. Select the matching Input Device in the same position as the corresponding Output Device.
When first running this version, all Input Devices will be deselected. You must set them in place 
and resave the preferences file before you will be able to record.

* A new SoundFile View Transcribe Mode option has been added to the Options Menu. This is a 
special mode of operation useful for transcribing audio dialog into a word processor. When this 
mode is active, certain elements about the SoundFile View Window change. The TimeLine area is 
replaced with a Hide/Show button, a time readout display and a Back-Step time display. The 
SoundFile View Window is now capable of becoming a TopMost Window allowing operation on 
top of other applications, such as a word processor. Playback operates slightly differently. 
Beginning playback is handled in any of the normal ways (including the Gameport FootSwitch), 
but when playback stops, the finished playback position time will be copied into the Windows 
Clipboard (which can then be easily pasted into your word processor document), and the start 
cursor position will automatically jump forward to the finished playing position minus the number 
of seconds of Back-Step, thereby giving an automatic built-in pre-roll for the next playback. This 
allows for very efficient transcribing, because playback will begin just in front of where you left 
off each time you start and stop playback. You may adjust the Back-Step time from 0-10 seconds. 
You may also jump the playback position forward or backward with the Left Mouse button during 
playback, just like in the Full View Window, allowing you to scan and search for a specific spot in 
the material to be transcribed. You may also use the PlayMark and PlayLoop features of the 
SoundFile View to help with difficult sections of material. The operation differs from normal in 
that the entire marked area will be played or looped regardless of where the starting cursor position
is set.

* A new option has been added to the Mix Menu called Snap Marked MixChanges To Cursor. This 
option can be used to precisely position mix changes to the MultiTrack Cursor location. For 
example... re-locating a fade to the exact beginning position of a slightly extended MT Entry 
Boundary. This option can only be used when track fader is open and a marked mix area exists. Try
this... use the fader Next button to snap the cursor to the beginning of a fade. Press the B key to 
mark the beginning. Place the cursor past the end of the fade and press the E key to mark the end. 
Use the Tab key to position the cursor at the entry boundaray and select this option from the menu 
or press the BackSpace key. The fade beginning will snap to the cursor position.

* Marking Entries in MultiTrack Select Mode has been enhanced. You may now select a range of 
entries without the need to drag across them. Select the first entry as usual. Then press the Alt-Key 
while selecting the last entry in the range. All entries inclusive will be selected. This will work 
across multiple tracks also as long as the last entry is on the same or higher track number.

* GamePort Switch control now also includes PlayMark (by holding down the Shift Key) and 
PlayLoop (by holding down the Ctrl Key).

* GamePort Switch is now active during a MultiTrack Preload waiting condition. 

* All Message Box prompts have been made TopMost so they will always be visible when first 
invoked, even on top of other application windows.

BugFixes



* The Goto Position feature will now create only one instance of the Input Number Dialog Box if 
you repeatedly click the Time Readout Display in SampleMode.

* The Waiting For SMPTE Trigger window will no longer dissapear when using MultiChannel 
Record Mode inputs on soundcard devices 2-8.

* Active Window Flashing has been adjusted to correctly repaint the title bar when the HelpFile or 
other application windows overlap it and are then moved.

* More work done on the Trigger Record and Chase Record and SRP modes to allow total control of 
punch-in and out when triggering to SMPTE.

* Clicking in MultiTrack TimeLine will now correctly update marked area display.

* Scrolling the MultiTrack Display Up or Down while re-ordering a track number, will no longer 
cause a program fault.

* The BlendEditList function will now properly blend SEQ Control Entries.

Version 2.2

Enhancements
* A new Auto MT PreLoad After Break option has been added to the Options Menu. When this 

feature is active, the MultiTrack will automatically preload after a Break Entry. A single press of 
any key will instantly begin playback from the cued state. This is very useful for live playback of 
multiple cues in a theatre application.

* SRP Recording with SMPTE Trigger is now sensitive to the SRP/REC link options. You may press
SRP alone and after trigger, press REC to punch in live on the fly. You may also use the Shift key 
to depress both SRP and REC at the same time, or use the Auto SRP/REC Link option in the 
Options Menu to latch the buttons together.

* Tempo Mode resolution in the VariPitch FX has been increased to 1/100th of a percent.

* Extending MT Entry boundaries past the beginning or end of the Region's file, now sets the Entry 
boundary at the file boundary instead of cancelling the function.

* A new GOTO Position feature has been added for SMPTE Modes and Sample Position Mode. If 
any SMPTE Mode is active, clicking with the Left Mouse Button in the Remote Transport Window
Current Time Readout display, will pop up the Enter SMPTE Window, allowing you to enter a 
SMPTE position which the MultiTrack Cursor will jump to. If the Sample Display Mode is active, 
the same mouse click will pop up the Input Number Dialog Box, allowing you to enter a 10 digit 
sample position which the MultiTrack Cursor will jump to.



* The Compressor/Limiter Gate Release sensitivity has been adjusted to give a more useful range of 
control. Any previously saved EDL's with the Gate function should be checked and possibly re-
adjusted. 

BugFixes
* The Page Fault has been fixed when attempting to start an FX Forced PreScan past the end of a 

marked area.

* Loop To Beginning Seq Control Entries will no longer null out following entries on the same track.

* The use of Shifted keystrokes when creating Region names in an unnamed EDL now works 
correctly.

* Deleting a Region which is referencing a bad or missing soundfile, now works correctly.

* Changing the Slope Value of a mix entry that is within a marked area, now works correctly.

>----<

Version 2.1

Enhancements
* The FX API has been enhanced to add a Forced Process Request option allowing newer plug-ins to

force a processing call right from the track beginning, even if there are no MT  Entries there.

* A new Blend EditListFile option has been added to the File Menu. This option allows you to blend 
the File, Region, Marker, Mix and Track Sequence data from an existing EDL into the current 
EDL at the MultiTrack Cursor position. The position must be chosen after the end of the current 
EDL. Once the data is on the MultiTrack, it can be positioned anywhere using the Select Mode 
positioning capabilities.

* A new Recover EditListFile option has been added to the File Menu. This option can be used to 
attempt a recover of the last EDL undo operation, even after a system crash. Simply choose this 
option to see a list of all EDL undo files. Select the session you are trying to recover and hopefully 
most if not all of your session will be recovered.

* A new Force FX Pre-Scan/Playback option has been added to the Process/Mixdown Menu. This 
option can be used to force an FX Pre-Scan and begin immediate playback so that you may hear 
PeakLimit and Normalize functions live, for example. This is also useful if you want to mix 
directly to DAT with PeakLimit and Normalize functions, and do not wish to process the data 
destructively, or build a mix to a separate soundfile. You may also mark an area and force the Pre-
Scan from the cursor position to the end of the marked area. In this manner you can test various 
sections of your session. Be aware, however, that peaks that are outside the marked area are then 
not included in the Pre-Scan, possibly altering the normalize scaling factors.



* The Default Undo Data Path option has been added into the Directory Path Setup Option under the
Options Menu. Use this to point to a large drive for all undo file storage.

BugFixes
* Importing EDL's from other versions of SAW will now correctly skipover Track-Order 

information and properly place Output Track data on the associated Output Tracks.

* ZoomFactors in the Options Menu are now correctly saved with the preferences.

* Page Fault Errors due to extreme cases of SampleRate Conversion/Vari-Pitch in the MultiTrack are
now trapped. Turning on Waveform display in the MultiTrack will show the entries that are out of 
range.

* The Latest Release Notes option under the Info Menu, will now properly work with folder names 
containing spaces.

* Zero-Cross detect will now properly adjust the SoundFile View cursor in Sample-Edit mode.

>----<

Version 2.0b

BugFixes
* This quick version update fixes an Accelerator Key problem discovered in the Sawplus32 2.0 

release.

Version 2.0

Enhancements
* This version marks the first release of the SAW32 spindown. Support has been added for cross-

loading EDL's between the different SAW products. You may even load EDL's from SAW 
products containing more tracks and/or outputs than the version you are using (for example 
SAWPlus to SAW32). All tracks and/or outputs beyond the current maximums will be thrown 
away. All output track info will be correctly shifted to the proper output tracks.

* Brand New Re-Written Help File. Check it out for detailed easy to follow instructions on operating
the SAW32/SAWPlus32 environment. Even if you are a seasoned veteran, we suggest reading 
through it all... you are sure to learn something new about the interface. 

>----<



Version 1.9

Enhancements
* Support has been added for generating 29.97 with the Opcode 8 PortSE and Studio 64X. If the 

Conform 30 to 29.97 is turned on with 30 Non Drop Format, 29.97 will be generated.

* Available SampleRates have been greatly expanded, now including video pull-up and pull-down 
frequencies of 44056, 44144, 47952 and 48048. A custom rate is now also available, allowing you 
to specify any SampleRate between 1000 and 99000. Please note that your soundcard must be 
capable of handling the selected rate or you will be given a warning at play or record time. You 
may also use the custom rate during a BuildMix operation to create output files for special 
application hardware.

* For proper operation in SMPTE DropFrame Mode, the SMPTEStartOffset must be set to an even 
10 min boundary. A reminder message will now display when this criteria is not met.

* A Warning message is now displayed when using Build Mix To Output Track and the selected 
output file already exists.

* SAW32/SAWPlus32 now automatically detects and compensates for any system audio device 
driver changes. If a selected audio device driver is no longer in the same driver list order, 
SAW32/SAWPlus32 searches and re-orders its device assignments. If it can no longer find an 
assigned device, it resets all devices and warns you to go to setup options and re-assign the devices.

* SAW32/SAWPlus32 now automatically detects and compensates for EDL's which use FX Modules
that were installed in a different order when the EDL was created. The old FX order is rearranged 
to match the current order. If an FX was used in the EDL that is not found on the current install, 
you will be notified and a '<Missing FX Module>' listing will display in the FX Patch List.

* Pressing the 'A' Key in Select Mode now selects ALL entries in the entire production.

* Pressing Ctrl-Delete in the Markers View Window now deletes ALL Markers.

* Build Mix To Output Track now only clears the output tracks that are active in the build. The other
output tracks remain untouched.

* The B Key and the E Key in the MultiTrack View are now sensitive to the Auto ZeroCross option 
and will now automatically find the nearest ZeroCross before marking the Begin or End point if 
this option is turned on.

* The Split Region functions are now sensitive to the Auto ZeroCross option and will now 
automatically find the nearest ZeroCross before performing the operation if this option is turned 
on.



* Break Entries in the MultiTrack will now automatically cue to the end of the Break, ready to play 
the next entry if one follows immediately.

* When selecting new entries in the Sequence List and Markers List with the mouse or Up/Down 
Arrow Keys, playback will now continue at the newly selected entry if playback is already active.

* Vari-Pitch adjustment using the slide bar has been adjusted to slowly single step up or down when 
just offset slightly from its center position. As the bar is moved further from center its speed and 
step size will increase simultaneously.

* Trying to create a version spinoff (using the Ctrl-Shift 1-9 keyboard option) when the current 
session has not been previously saved as an EDL File, will now display a message box reminding 
you to first create and save the session as an Editlist File.

* Replace Entry in the MultiTrack is now un-doable and will prompt for confirmation when using 
the Menu option, and skip the confirmation prompt when using the 'R' keyboard shortcut. 

Bug Fixes
* Opening new soundfiles will now automatically clear Zoom Magnify Mode. This applies to 

double-clicking Regions from the Regions List or any other manner that SAW32/SAWPlus32 
opens a new soundfile into the SoundFile View.

* Modification was made to allow 29.97 Conform to stay active during SMPTE Generate Mode.

* Performing a Fade To Next Mix Change after placing Pan information will now work correctly and
no longer cause Application Errors.

* Crossfades with Marked Areas onscreen will now properly trap and warn when the cursor position 
crossover point is outside the Marked Area boundaries.

* A PageFault error which could be caused by resizing MT Entries with names larger than 32 
characters, has been corrected.

* The Sequence Control ListBox Window will no longer cover-up dialog box warning messages.

* Command Line Processing has been fixed to allow spaces in passed SoundFile names.

* Chase-Trigger Record now functions correctly from Rec-Rdy Mode or Stop Mode.

* SMPTE Format for Generating SMPTE will now be properly detected from EDL or Preferences 
without having to first open the Smpte Format/Stripe window.

>----<

Version 1.8



Enhancements
* The single step up and down areas on the mixer fader will now step in 1db increments if the Shift-

Key is pressed while clicking.

* Fades (drawn as white linked together mix changes) can now be stretched or shrunk to a new size. 
Place your cursor within the fade boundaries and press the CTRL Key and Left Mouse button near 
the beginning or end point of the fade. The cursor will change shape and you can now slide it to a 
new location and release. The fade will be redrawn stretching or shrinking its original curve shape. 
You can not move the fade beginning in front of a previous mix change or past the end of the fade 
ending. You can not move the fade ending in front of the fade beginning or past the next mix 
change. To stretch just a portion of the fade, zoom in and add a mix change somewhere in the 
middle of the fade to break the join, then stretch either side or both separately.

* You can now adjust existing volumes and pans within a marked range in the MultiTrack by placing
your cursor within the marked area and adjusting the fader or pan knob. All settings within the 
marked area will be offset according to your adjustments. This is actually rewriting the data values,
but is keeping track of overuns and underuns, so you can recover the settings by adjusting in the 
other direction. Place the cursor on a volume section that is not zero db and the fader will trck the 
adjustments. Place the cursor on a zero db section and the fader will snap back to zero db after each
adjustment, reacting like an offset control.

* Most Marked Mixer functions now also remove the marked area when finished saving an extra 
keystroke for most operations.

* The Next Button on the Mixer Faders has been divided into backward and forward sections. 
Clicking in the left half of the button will move backward to the previous mix change and clicking 
in the right half moves forward to the next mix change.

* Marking the SoundFile View or MultiTrack View can now be accomplished without the need to 
press the Shift Key while dragging the mouse in the TimeLine area. Clicking the Right Mouse 
button in the TimeLine area will clear the marks. When Select Mode is on, marking will not occur 
and the Right Mouse button in the TimeLine area will toggle playback as before.

* Latching Buttons have now been Color Enhanced for more visibility of latched state.

* Modifications were made to the 'SMPTE Passed Cue Point' warning message to allow for 
continued SMPTE display until SMPTE is stopped.

* Enhancements to the SMPTE Generate support of the Antex Studio Card which now controls all 
frame rates including 29.97. Selecting 30N or 30D Frames Per Sec in the SAW32/SAWPlus32 
SMPTE Stripe/Format box with the SMPTE Conform to 29.97 ON, will generate 29.97 Non or 
Drop code.

* The Process and Mixdown options have been enhanced to process in the background if desired. 
Once the BarGraph window is displayed, pressing the Esc Key is the now the only way to cancel 
the operation (this eliminates accidental keypresses from aborting); pressing the Enter Key will 



minimize SAW32/SAWPlus32 and allow processing to continue in the background. You may 
restore SAW32/SAWPlus32 at any time from the taskbar or other normal Windows methods.

* A Horizontal ScrollBar enhancement has been made to the MultiTrack and SoundFile Windows. If 
you accidently click in the scrollbar area and snap the cursor position to the beginning or end of 
your working view, simply press the Shift Key and click on the scrollbar slider to return you 
instantly to your last cursor position.

* The MultiTrack View horizontal scrollbar positioning will now center the MultiTrack cursor much 
like the SoundFile View.

Bug Fixes
* Random 'File Not Found Msgs' after entering Names and KeyCodes on a fresh install have been 

fixed.

* One more attempt at fixing inaccurate Drive Time Remaining values in the Record Remote Panel 
for large (> 4 Gig) drives.

* Meter Bridge will now display properly even when a Relative Zero Offset Time has been set in the 
MultiTrack.

* More fixes in the SMPTE modes to give overall tighter SMPTE performance.

>----<

Version 1.7

Enhancements
* A Notification Message has been added when Saving EDL Files.

Bug Fixes
* MultiChannel Record Fader Windows will now properly adjust their own respective faders.

* MultiChannel Record Mode meters will now properly clear the Peak indicator on meter reset.

* Record Meter margin displays will now correctly max out at 100%.

* SRP MultiChannel Record will stop properly if you push the machine past its limits and receive the
'Machine Not Fast Enough' message.

* Changing the Drive Letter in the Record Remote Window when in MultiChannel Record Mode 
will no longer cause a crash.

* MT SMPTE Trigger will now wait properly for trigger.



* MT Chase Trigger will now properly display Wait Message Box.

* One more attempt at the elusive CompLimiter and Echo Modules Divide By Zero startup crash.

>----<

Version 1.6

Enhancements
* You may now associate EDL, WAV and SND files in the explorer to automatically run 

SAW32/SAWPlus32 when you double-click on them. Double-click an EDL, WAV or SND file in 
the Explorer and an associate dialog will pop up. Select Other for the program and browse to find 
SAW32/SAWPlus32.EXE. WAV files may already be hooked to some other application and this 
association can be removed by using the Registry Editor. Open the HKEY_CLASSES_ROOT 
section and delete the folder for WAV. Now you may freely associate SAW32/SAWPlus32 with 
WAV files if desired. You may also use a command line hook to auto start SAW32/SAWPlus32 
and load and begin playback of a SoundFile or EditList File. Include a /P after the filename in the 
command line parameters.

* MultiChannel Record Mode has been activated. This is an exciting new enhancement to the 
SAW32/SAWPlus32 environment. It allows the MultiTrack to operate more like a standard 
MultiChannel tape recording system for use in a live recording situation. MultiChannel Record 
Mode can be toggled On/Off from the MultiTrack Menu. Its state will be saved with the 
Preferences and each EDL. Once turned On, recording in SAW32/SAWPlus32 operates quite 
differently than normal. First, each track that you arm for record will now automatically record 
Mono Audio Data to one of up to 16 SoundFiles at the same time. There will be a SoundFile 
assigned to each SoundCard input in your SAW32/SAWPlus32 system. If you have 2 stereo 
devices, you will be able to treat them as four independent inputs, much like a multitrack tape 
recording system. The Base Filename for each session (or record operation) is first set in the 
MultiChannel Record Mode Setup option on the MultiTrack Menu. This Base Name can be setup 
once and forgotten about for an entire session, or you may freely change it many times within the 
same session. The last Base Name set will save with the EDL. SAW32/SAWPlus32 will append 
'_Card_1L',' _Card_1R' for each Soundcard assigned to a recording channel. All data will 
continually be appended to these files and Regions and MultiTrack Entries automatically created 
during recording. This still retains the power of a Non-Linear System, but on the surface looks 
more like a simple arm and record Linear type operation. For each push of a MultiTrack Record 
Button, a small single channel meter will pop up. These meters will attach themselves into a 
straight line in order of Track assignment. The default input connection will follow the Output 
Card assignment for the particular track, starting with the L side (if available) then the right side. 
Dashes will be displayed if all inputs for the default card are already assigned. You may click on 
the In Display at the bottom of the meter to obtain a list of all available input selections. You may 
freely assign the input with no regards to the track's output assignment. The small fader icon will 
pop up an input fader if needed to adjust input level. Simply pressing Record or SRP/Record 
begins the recording process. Pressing Stop or SRP (to punch out), will automatically place the 
Region entries on their respective tracks. You may playback the recording, and if you use the Auto-
Rewind feature on the main Remote Panel, the play cursor will automatically reset to the exact 



starting position each time. If you decide to Retake the recording, pressing the Retake Button will 
remove all the Regions and MT Entries created by the last recording, and reset the file positions to 
the last position before recording started. In this way you will not waste disk space for recordings 
you did not like. If you decide to keep the recording but would like to try another at the same spot, 
press the KeepTake Button, and each Region Name belonging to the last recording will be 
appended with a unique Take Number and the actual Sample Position insertion point. The 
MultiTrack will be cleared and the cursor returned to the starting point, but the file positions will 
not be altered. Therefore recording again will retain the last recorded information. You will also 
find it easy to do multiple vocal takes or harmony guitar solos etc... by setting up a track to 
record... assigning the input (which will stay the same between overdubs)... and doing your first 
track's recording. Now to change to another track and do a harmony part, simply click inside the 
Track Number Display at the top of the meter. A list of available tracks to move to will be 
displayed. Select one, and all internal assignments and file handling will be done automatically, so 
you can begin recording immediately. You can setup a template for typical emulation of a 
multitrack tape system in this way... Start with a clean EDL... Arrange the first group of tracks on 
the MultiTrack to point to each installed SoundCard a pair at a time... For instance, Track 1 to Card
1, Track 2 to Card 1, Track 3 to Card 2, Track 4 to Card 2... and so on for each installed pair of 
inputs... Now, bring up the fader on Track 1 and press the Offset Button... Pan all the way Left... 
Close the fader and bring up the fader on Track 2 and Offset Pan all the way right... Follow this 
procedure all the way down for each track assigned to a different SoundCard... Turn on 
MultiChannel Record Mode and save your EDL and name it 'MultiChannel Record Template', or 
whatever you like. To instantly setup a MultiChannel Record Mode Session, open this template 
EDL, enter a Base Name in the MultiChannel Record Mode Setup and immediately save and name 
your session. Now when you arm a track for record, it will automatically pick up the exact input 
matching channel, just as if you were using an ADAT or some other type of multitrack tape 
system. Each track will output through its specific card's output to your external mixer and you will
be emulating the feel of your oldstyle multitrack tape system. If you use the CTRL Key when 
closing the meter panels, all will close at once.

* The Normal Recording Mode has been altered to take on some of the enhancements introduced in 
the MultiChannel Record Mode. When recording direct to the MultiTrack, the Stop Button will 
now automatically drop the recorded region entries onto the track as if you had used the punch 
in/out feature. This enhancement allows you to listen back to your recording before leaving the 
Record Panel. All parameters concerning the last recording are retained so that the Retake and 
KeepTake features can still be used. Retake will remove the last recorded entries and regions, and 
KeepTake will name them with a unique Take Number and the actual Sample Position where they 
belong in case you decide to use them in your session at a later time.

* The MultiTrack Patched FX icon will now display a slightly different broken link when the bypass 
switch is turned on. This makes it much easier to spot tracks which have patched in effects 
regardless of the state of the bypass switch.

* Position Tracking is no longer dependent on Wave Device Drivers. New assembly language code 
has been added to chase-lock the position to the actual sample buffers as they are clocked out. This 
should eliminate discrepencies between soundcards as far as position reporting and FX Meter 
Bridge timing accuracy.



* The Delete Key will now function the same as the Shift-C Key in the MultiTrack View to clear all 
mix changes within a marked area if the Mixer Fader is open for the current hot track. If the Mixer 
Fader is not open then the Delete Key will operate as before... removing the current Seqence Entry 
(under the cursor).

Bug Fixes
* The 'S' Key has been trapped during MT Playback. Select Mode should not be allowed to toggle 

during playback.

* BuildMix Access Fault Error has been corrected. This is a bug created in 1.5 when changing 
memory management technique.

* Chased down more MessageBox windows that were not acting as System Modal.

* CompLimiter and Echo Module Divide By Zero and Access Error bugs on startup were fixed.

* MultiTrack Cursor will now report the correct end position when playback stops at the end of the 
session.

* Split Stero File has been fixed... it will no longer destroy memory pointers.

* 64 Bit variables are now being used to provide accurate calculations for time remaining on drives 
larger than 4 gigs.

* MultiTrack Re-Cue (Mute, Solo, Fader, Bypass, etc...) has been corrected to react properly to mix 
change info.

* Warning Message Boxes will now properly display above the Get EDL Region Window.

* Open Editlist will now correctly identify missing files in the Warning Box.

* MultiTrack Marked Fades will now correctly update the screen when tracks are ordered out of 
sequence.

* Updating a MultiTrack Region Entry and making it smaller, will no longer pull mix changes from 
non Butt-Spliced entries forward.

>----<

Version 1.5

Enhancements
* Record Mode in the MultiTrack will now advance the cursor position and perform calls to FX 

PlugIn Modules for position tracking.



* Enhanced Memory Management techinques eliminating all use of memory handles.

* Enhanced FX API additions to track SMPTEFormat, SMPTEStartOffset and Program Version 
Number.

* Crossing into Sample Edit Zoom now changes the cursor to the Sample Edit Mode X cursor. This 
now alerts the user that sample editing is active. Using the Shift - Left Mouse Button will now grab 
the nearest sample for adjustment rather than begin a Drag/ Drop Region to the MultiTrack.

* Pan controls now have a Left and Right Arrow zone. Clicking in either zone with the Left Mouse 
button will shift the pan control one setting.

* Adjusting the Track Order now allows virtual up and down scroll of the MultiTrack Window while
moving a track number to a new position.

Bug Fixes
* The Win95 disappearing boot drive problem in the Record Panel Drive / Time Remaining Status 

window has been corrected.

* Simultaneous Recording from multiple card drivers will now correctly drop all entries at the proper
start position on the MultiTrack.

* Opening SAWPlus EDL's which contain Break or Loop To Beg Seq Control Entries will no longer 
crash during the conversion process.

* The Remote Window and Record Remote Window will no longer appear as a blank button on the 
task bar when in the Hide/Show on-top mode. They are now designated as floating TollBar 
Windows.

* Sample Edit Mode should now work properly with 8 Bit Mono or Stereo Files.

* Sample Edit Mode wrap around when adjusting the new value to max extremes has been corrected.

* FullView wave drawing of short files has been corrected.

* Seq Entry calculations of boundaries and lengths on tracks involving sample-rate conversion or 
vari-pitch are now done at a much higher resolution eliminating most all of the roundoff error.

* The Undo function for SoundFile modifications will now restore files to their correct original 
length even if a paste operation extended the length.

* Chased after the elusive double MultiTrack Cursor Thread Synchronization problem. Hopefully 
this will eliminate the appearance of double cursors for good.

* Changes were made to the EQ, CompLimiter and Echo modules to ease the problem in NT of 
setting values with the mouse push/pull interface. NT does not seem to send mouse movement 
messages when the mouse is rapidly pushed past a clipzone. The mouse X motion was widened to 



include the entire rectangle for each adjustable value. This helps the problem by allowing side 
movement when the upper and lower limit are reached. By slightly jiggling the mouse when 
pushing or pulling, you will improve the chances of not freezing the motion.

>----<

Version 1.4

Enhancements

Bug Fixes
* All Plugins have been recompiled to correct a problem that could trash preset data for other 

modules. 

* Setup Program has been modified to detect existing .INI files and not overwrite them during an 
update operation.

* The Sample Edit Mode Zoom display has been corrected to eliminate a wrap around line effect that
could appear on certain systems using Windows 95.

>----<

Version 1.3

Enhancements
* Enhanced Zoom now takes you beyond 1 sample per pixel. ZoomInFull still stops at 1 sample per 

pixel, but continued use of the ZoomIn function displays the actual sample points as small squares 
spread out by a fixed number of pixels. You may utilize the Sample Edit Mode by holding the shift 
key and clicking with the left mouse button on or near a particular sample square. You may then 
change the sample value by pushing up or down with the mouse, and the SoundFile and 
PeakDataFile will be instantly updated. Note that you may also use the Up and Dn amplification 
buttons for finer value alterations. This feature offers an incredibly easy method of pop and scratch 
removal. Simply zoom in and adjust the samples that are radically different to create a smooth 
curve transition with the adjacent samples.

* The Shift-V Clear Marked Vol Changes option will now physically remove any mix entry within 
the marked area that does not have a unique pan setting. If there are no enclosed pan changes this 
function now works exactly like the Clear Marked Vol And Pan Changes function, removing all 
entries within the marked area.

* The Shift-P Clear Marked Pan Changes option will now physically remove any mix entry within 
the marked area that does not have a unique volume setting. If there are no enclosed volume 
changes this function now works exactly like the Clear Marked Vol And Pan Changes function, 
removing all entries within the marked area.



* Fade Out / Fade In Marked are now transparent to pan changes within the marked area, 
superimposing the fade over top any existing pan information.

* Crossfades are now transparent to pan changes within the marked or overlapped area, 
superimposing the crossfade over top any existing pan information.

* SRP Recording has been enhanced. The multitrack cursor is now independently controllable and 
will no longer be automatically updated at the end of the recording process to the end of the newly 
recorded entry. You may now use the Remote Panel Auto Rewind button to force the multitrack 
cursor back to the original start position after you stop recording, ready for another take. You may 
now punch-in independent of the playback starting position, and when you stop recording, the 
cursor will return back to the original starting position, not the recording punch-in position. By 
marking the desired recording range in the multitrack, you can simply press SRP and the recording 
will automatically punch-in and out at the proper positions. When you stop, the cursor will be reset 
ready for another take. By marking the end position much beyond where you will stop recording, 
you will have an automated in point but you will stop the recording manually. Doing things this 
way allows you to decide on retaking or keeping the last take, which can make better use of your 
harddrive space when doing multiple take recording sessions. 

* Enhanced error checking during EDL saves will warn of any trouble during the save operation. The
Update EditList Function will now beep through the computer speaker as an indication that all 
went well.

Bug Fixes
* Right Clicking on an empty Regions List will now correctly display warning message box.

* Changes were made to most warning message boxes to latch them to the main window instead of 
the desktop.

* More work was done on the elusive MultiTrack Waveform Display causing track sync slippage. 
This time, it should be fixed.

* The Update MultiTrack Entry function now functions correctly when modifications are being made
near the MultiTrack Zero position.

* Fade To Next Mix Change will now correctly allow you to start the process from a position directly
on an existing mix change. This now works exactly like the Sweep Pan to Next Mix Change.

* MultiTrack Display Buffer Size adjustments were made to help eliminate waveform display 
problems when doing samplerate conversions from 11025 to 48000.

>----<

Version 1.2



Enhancements
* Slopes are now displayed in the fader view on the MultiTrack. A Green Line will show the slope of

each mixer entry and slope adjustments are displayed immediately when altered. Note that volume 
changes are instantaneous at entry boundaries that are not butt-spliced to another entry.

* A new Mix Menu Option called Fade Curve Setup has been added. This allows selecting and 
modifying the current Fade Curve parameters used for MultiTrack Fades. This option can now 
remain on screen while creating groups of fades, allowing rapid selection of different fade 
parameters. The Setup Window has been moved from the Fade To Next Mix Change option.

* Marked Fades and Crossfades are now automatically adjusted to within entry boundaries. They will
no longer write into an empty area on a track.

* Default Slope Factor will now save with the preferences. Simply set the slope value you desire and 
save preferences.

* The Undo command has been extended to handle many more EDL modifying operations.

* A new Info Menu Item called Latest Release Notes has been added. Clicking on this option will 
display this document directly.

* A new Info Menu Item called Help Tutorial has been added to take you straight to the tutorial 
section.

Bug Fixes
* Output Track mix changes are now handled correctly. They will no longer jump to Entry 

boundaries that are on other tracks.

* Mix changes will no longer jump entries on tracks that are out of normal track order.

* MultiTrack display waveform redraws should no longer cause track sync slippage.

* EQ, CompLimiter and Echo Load and Save Presets are now working properly.

* CompLimiter compressor and limter functions will no longer shift the pan position when multiple 
units are patched.

* Currently selected Audio Card is now properly displayed in the Record Panel.

* Assign Regions to MIDI Notes should now work correctly.

* BuildMix To Output Track should now do SampleRate Conversion properly.

* BuildMix functions should now correctly identify a marked range even if the range is not visible on
the screen.



* Playing a blank area on an Output Track with the Output Track Solo engaged will now properly 
play silence.

* Joystick motion sensitivity is now set high while SAW32/SAWPlus32 is active to help eliminate 
possible streams of joystick motion messages from overly sensitive joysticks. This could cause 
system slowdown. The joystick services are used to detect the gameswitches for certain operations 
in SAW32/SAWPlus32.

>----<

Version 1.1

Enhancements
* Enhanced CrossFades now also use Fade Curve Parameters for more precise control.

Bug Fixes
* Loading SAWPlus 16 Bit EDL's should now correctly retain FX Module settings.

* SMPTE Format should no longer change to 24 FPS when opening the Set SMPTE Start Offset 
Window.

* FX Echo should now correctly process between Sequence Entries.

* WAV headers are now correctly written during Recording and Build Mix operations.

* Split Region And Cut MT Entry operations should no longer corrupt Sequence Entry information.

>----<

Version 1.0

Enhancements
* Flat 32 Bit Native 95 / NT Code.

* Enhanced Wave Audio MultiThreaded handling routines can take advantage of Priority Threading 
and Multi-Processor support in NT.

* Enhanced Midi/Smpte MultiThreaded handling routines can take advantage of Priority Threading 
and Multi-Processor support in NT.

* Enhanced cursor and position update MultiThreaded handling routines can take advantage of 
Priority Threading and Multi-Processor support in NT.



* Enhanced Disk handling routines.

* Less Hard Disk head seeks per MultiTrack Loop.

* Larger Wave buffer size requires less Interrupts per second.

* The MultiTrack has been expanded to 24 tracks of  mono or stereo data, allowing a maximum of 
48 tracks of Realtime Audio Playback on a high performance machine.

* Support for up to 8 Stereo Wave Devices has been added, allowing a maximum of 16 physical 
channels In and Out. 

* Fader Vol Resolution has been enhanced to 1/4 db steps.

* Each Mix Step is now ramped according to a Slope Setting, resulting in enhanced resolution below 
1/1000 of a db and smoother noisless fades.

* New Fade Curve Window allows selection of different internal high precision Fade Curves with 
Step Size adjustment. The design allows for the creation, saving  and selection of custom curves to 
be implemented in a future update.

* Marked Area FadeOuts and FadeIns also use Fade Curve Parameters for more precise control.

* Enhanced Keyboard shortcuts for fade functions bypass all prompts allowing much faster 
operation.

* Mix changes are no longer permitted between Sequence Entries. The cursor is automatically 
advanced to the start of the next entry or the end of the previous entry if there are no entries past 
the cursor position.

* Long FileNames.

* Enhanced Zero Cross lowest energy point detection.

* MultiTrack Smart Tab will now Re-Center the screen only if a scroll was needed.

* '=' Key can now be used to instantly center the cursor position on the SoundFile or MultiTrack 
display.

* Enhanced VariPitch Resolution to 1/100 of a percent in the Time Mode.

* Enhanced 32 Bit API stores all FX Module Settings directly in the EDL, allowing all EDL 
Versions 1-9 to now correctly identify different FX Settings.

* Support for the Antex Studio Card SMPTE Generator has been added.

* New Keep Take Button In Record Panel allows you to keep takes and instantly do another. All 
takes are automatically regioned for easy later retrieval.



* New Auto SRP/Rec Button link. Presses both buttons together without the use of the Shift Key. 
Use this in conjunction with the Retake Button to assure that each take is started at the same 
position reference.

* GamePort Switches are now supported through the Joystick services, allowing GamePort Switches 
to function properly in both 95 and NT. Simply make a 15 pin din plug to emulate a joystick. 
Solder a 150K resistor between pins 1 and 3. Another 150K resistor between pins 1 and 6. Switch 
or Relay 1 goes between pins 2 and 5. Switch or Relay 2 goes between pins 7 and 5. Go to the 
Control Panel in Windows and select Joystick. Choose Custom and test your buttons.

Bug Fixes

Removals
* Session Archiving has been removed. With so many tracks available and so many new features to 

support, including the soon to come 32 Bit Data Path, Archived Sessions to Audio DAT has 
become impractical. We now recommend using inexpensive Data Tape Backup Devices, Jazz 
Cartridge Type Devices, or CDROM to backup sessions.

* ChaseLock Resolve And Observe options have been removed. Newer SoundCards can now handle 
lock to LTC, VITC, WordClock, Video Sync etc. at a hardware level, outperforming our software 
emulation. We recommend looking into one of these cards if this feature is needed.

* Analog / Digital switch in the Record Panel has been removed. This function required specific 
proprietary code for each soundcard supported. Most new soundcards now have many proprietary 
functions that we cannot support directly. Each card will most often have its own mixer/utility 
applet that will control all the special features of that card.

>====<


